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This 2016-2017 Manual contains some updated nomenclature references (shown in green) in Joy of
Tournaments Debate Tiebreakers that should help bring some additional clarity to the program.
Some updated items and items of special importance are highlighted in red throughout the manual.
All Joy of Tournaments support is managed by Stoa Tab.
• Please contact tab@stoausa.org with any questions.
• Please do not contact Joy of Tournaments with support questions.
Stoa supports local tournament control in the setting of openness and transparency.
For local tournaments, changes may only be made to Tabulation methods described in this manual (e.g.
tiebreakers, power-matching process) if announced in writing on the tournament registration website
before tournament registration opens in keeping with the signed Stoa Tournament Registration Form.
[This does not apply to Section W, as these are simply recommendations and not tabulation methods.]
Joy of Tournaments requires Windows XP or newer.
Joy will run under the latest Windows versions including Windows 10.
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A. Install Joy of Tournaments
1. New for 2016-2017
a. Joy of Tournaments no longer requires a software registration key.
b. Those familiar with Stoa Tabulation and Joy of Tournaments are aware that
previously Stoa Tournaments were expected to make a donation to Joy of
Tournaments to support Mr. Hinkle. This is no longer the case and the software may
be used at no cost to local clubs.
c. Tournaments using the stand-alone application (as is done at Stoa tournaments) may
use the software free of charge.
i. About the author
I. Brent Hinkle, author of Joy of Tournaments has made a very generous
arrangement with Stoa Tab personnel for use of his software, programmed
specifically for Stoa, at all Stoa tournaments.
II. Mr. Hinkle is Christian gentleman and computer programmer, with a heart
for Christian homeschool forensics.
III. Mr. Hinkle has worked extensively with Stoa Tab personnel to customize
the software for use at Stoa tournaments without accepting any
compensation in return.
IV. Mr. Hinkle has provided many hours of technical support to Stoa Tab
national staff. He normally charges extra for this service, but has never
billed Stoa for his time.
ii. Please do not contact him directly or Joy Support, as Stoa Tab
(tab@stoausa.org) provides all technical support for Stoa tournaments.
2. Information is also available on the Joy of Tournaments website
a. www.joyoftournaments.com
b. The complete Help Manual from the Joy of Tournaments website may be downloaded
at www.joyoftournaments.com/help
i. Click on “Tab Software Training Notes” for the comprehensive Joy Manual
(PDF file). It is a large file so be patient.
I. http://www.joyoftournaments.com/help/JOT Training revision date Aug
2010.pdf
3. To download and install the software
a. Navigate to http://www.joyoftournaments.com/update.asp
b. Download the full software using this link on the Joy website (if you have not
previously installed Joy of Tournaments on your computer):
i. Full Version Self-Extracting Executable [33.0 MB] (this is not a clickable link
in this document)
c. If you already have Joy of Tournaments installed on your computer, you should
update the software to the newest version by using this link:
i. Update with Self-Extracting Executable [3.5 MB] (this is not a clickable link in
this document)
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d.

B.

Follow the directions contained in the “Help Installing this Version” link on the Joy
website immediately to the right of the above links.
i. Click on the “Windows XP Installation Instructions”
ii. In newer versions of Windows you may need to run the file as an administrator
(or log in to the Administrator account) in order to install the software. Find the
downloaded file titled “trial.exe” (or “trial1.exe,” “trial2.exe,” etc, if you have
downloaded more than once) and right click on the file and choose “run as
administrator.”

View your Tournament Registration Website or Registration File
1. Find all the student names that need some kind of attention
a. Names not capitalized or names in ALL CAPS
b. Eliminate middle names – long names don’t display well in Joy (they crowd the
postings) or when they are uploaded to Speechranks
c. Eliminate II or III or Jr. – these also don’t display well
d. Eliminate nicknames – there is not enough room to display both given name and
nickname
e. These caveats need to be checked for in both the student’s primary registration and
for the student’s listing under partner registration
2. Check for club name anomalies and duplications
a. Decide what names your want for clubs in Tab and how you want them displayed –
Please also check how they are displayed on Speechranks
i. E.g., Scarlet vs. SCARLET
ii. Please keep the names the same as on Speechranks or two clubs will be created
on Speechranks with the same students divided between what Speechranks
thinks are different clubs
3. Students (and associated data) can either be input manually or imported into Joy
a. Smaller tournaments may find it simpler to manually input all student information
into Joy
b. Larger tournaments will likely find it easier and faster to import all student
information into Joy
4. Export the student list for later entering (either manually or import) into Joy
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5. The following is specific to Flowpad Tournament Registration
http://www.homeschooldebate.net
a.
b.
c.
d.

Click the Students tab along the top of the window
Click Export These Students
Click Deselect All
Check the following boxes in the Students Columns
i. Student last
ii. Student first
iii. Debate Club
iv. Speech Club
v. Events at the tournament, e.g. Apologetics, DI, Duo, LDV, Parli, etc.
vi. Check all the boxes for items listed under Partners
I. Duo Interpretation partner first
II. Duo Interpretation partner last
III. Team Policy partner first
IV. Team Policy partner last
e. Click Export
f. This produces a CSV file (Comma Separated Values)
6. If you are confident that all students are registered with just one speech and debate club,
then you can upload this file directly to Joy. Concatenate (combines the first and last
name together) partner names first. Alternatively, you may use the Flowpad to Joy
Converter. It automatically concatenates the names for you.
7. Flowpad to Joy Converter
a. Available on the StoaUSA website at http://stoausa.org/help-files/
i. Click on the Tab Help button
b. Creates CSV files that can be uploaded to Joy of Tournaments for students
participating in separate clubs for speech and debate
c. Performs concatenation function automatically
d. Also assists in the following functions:
i. Creating CSV Student Contact file for Speechranks upload
ii. Creating labels for student ballot envelopes
iii. Creating badges for students
iv. Creating “Tents” for debate events
e. Follow the directions in the Flowpad to Joy Converter Excel spreadsheet on the
“Instructions” tab in the lower left hand corner of the spreadsheet.
f. See Section H for details on importing students into Joy
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C. General Tournament Setup in Joy of Tournaments
1. Launch Joy of Tournaments
a. If you get the message that a tournament is locked and a question about whether you
want to override the lock -> choose Yes
2. About Joy of Tournaments
a. Left Window Pane is navigation
b. Right Window Pane is the work area
i. Anything in the right pane can be printed by right-clicking -> Print
c. Menu Bar at the top
d. Learn to right-click
i. If you can’t find something, try right-clicking
ii. There are two or three ways to accomplish most tasks in Joy
3. File -> New
4. File -> Save
a.

Opens Save As dialogue box
i. Navigate to where ever you want to save your tournament
ii. Click the Create New Folder icon (it looks like a yellow folder with an asterisks
in the upper right hand corner)
iii. Name the New Folder
iv. Be sure to then navigate into the folder you just created so that the dialogue box
shows Save In the folder you just created
v. In the File Name box
I. Erase the *.trn and replace it with whatever you want the file name for your
tournament to be. It does not have to be the exact same name as the
tournament, but this is an easy way to remember it
vi. Click Save
I. The active tournament file will always be saved in this folder
II. All backups will be saved within this folder in a folder titled “Bak”

5. File -> Properties
a. Shows a dialogue box with a number of Tabs with are dealt with on the next page
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6. Tabs – only those listed need attention or action
a.

General
i. Name
ii. Start Date and End Date
iii. Backup – specify a time interval, usually best to use 15 minutes
iv. Path – shows the file pathway to where your tournament is saved
I. If you are ever unsure where your file is being saved, you can click the
“Find Data File” button and the program will take you to your data file.
v. Single Expand Tree – checking will limit the expansion of the navigation tree in
the left window pane. Some like this, some do not. Use what works for you.
vi. Log Add/Drops – check
vii. Validate on Exit – check

b.

Options
i. The following boxes should be checked. All others should not be checked.
I.
Label Speaker Position
II. Hide Codes on Ballots
III. Ranks skip on ties
ii. School Order on Tree
I.
Alpha – alphabetize by club name
II. Code – alphabetize by club code
III. You can always change it later.

c.

Styles
i. Stoa Tournament – Check
ii. Click Apply and you will receive confirmation concerning Stoa presets
I.
If the Stoa Tournament box is already checked, it is recommended to
uncheck the box and click “OK.” Then go back to File -> Properties ->
Styles and recheck the Stoa Tournaments box and click “OK.”

7. Import previous tournament information – if you have used Joy for a previous tournament
this is a definite time saver
a. File -> Administration -> Import -> Import prior tournament data
i. Choose what information to import
I. E.g. Schedule, events, sweepstakes, rooms, etc.
8. Add Events
a.
b.
c.
d.
e.
f.

Right-click Events -> Add
Plan how you want to input events
The events stay in the order entered
Alphabetical vs. Pattern
Consider alphabetizing and putting LDV, Parli and TP at the bottom of the list
Right-click any event to get to Properties for that event
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9. Event Properties – Right-click on any event – Tabs are as follows
a. Basic
i. Abbreviation, Name and Pattern
ii. Method
I. Section for Speech
II. Pair for Debate
iii. Type
I. Team of 2 for Duo, TP, Parli
II. Individual for all else (including LDV)
iv. Options
I. Draw – allows for listing of the Draw Time for Extemp (Some like this and
some don’t like to use - because if the schedule changes they have to
change the times on the postings)
b.

Rounds
i. Enter all the rounds and times
ii. For debate events, enter rounds all the way to finals so that the brackets
display correctly. Do this even if the tournament stops short of finals.
iii. Panel the correct number of judges for Prelims and Outrounds
iv. Check Flight if flighting the event (If Flight Times desired on Postings and
Ballots – see “e. Miscellaneous” on the next page.)
v.Check Flip for Sides in debate Outrounds
vi. Copy rounds from the same pattern to save repetitive entry

c.

Rooms
i. Rooms can be added to each event after the rooms are entered – See E below.
ii. Rooms can be entered into Joy at anytime. If they have already been entered, they
can be added to events at this step in the process
iii. Right-click Events -> Rooms
iv. Try to do these alphabetically as this is how they will display on the postings. It is
generally easier for students and parents to see the rooms listed alphabetically. If
you go back and make changes, the rooms will be listed in the order in which they
have been listed or changed.
v. Copy the rooms from one round to the next

d.

Options
i. Allow ties for last place on ballots - Check for speech events
I. Absolutely necessary to level uneven panel sizes
ii. Label Aff/Neg as Gov/Opp (Parli) – Check for Parli events
I. This will label all ballots and postings appropriately for Parli

e.

Misc - this is the Tab that sets up Tabulation for the tournament
- this Tab is also where Flight Times are entered
For local tournaments, changes may only be made to Tabulation methods described in this
manual (e.g. tiebreakers, power-matching process) if announced in writing on the tournament
registration website before tournament registration opens in keeping with the signed Stoa
Tournament Registration Form.
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i. Speech Events
If the presets are not as listed, go back to the tournament set up under Admin -> Properties ->
Style Tab and unclick Stoa Tournament and click OK. Then go back to the Style Tab and recheck
Stoa Tournament and check OK. Stoa presets should now be available for choosing. This process
must often be followed if you are using data from a previous tournament to set up a new
tournament.

I.

Tabulation Method – STOA.SPEECH
a. If you click edit, the tiebreakers should be
1. Low Cumulative Rank = win for lowest total cumulative rank
points
2. JP (Judge Preference) w/ 3-way Head to Head = breaks three-way
ranking tie based on which student “wins” the most judges
3. Judge Preference = breaks two-way ranking tie based on which
student “wins” the most judges
4. Sum of Inverse Reciprocals = win for highest total from adding the
reciprocal point rank values (e.g. 1st is 1/1 = 1;
2nd is 1/2 = 0.5; 3rd is 1/3 = 0.33; 4th is 1/4 = 0.25;
5th is 1/5 = 0.2; 6th is 1/6 = 0.167; 7th is1/7 = 0.143; etc…)
5. Head to Head = win awarded to student who bested other student
in prior round
6. Prior Cumulative = win awarded to student with best placing prior
to current round

II.

Prelim Ranking Rules – STOA.PRELIMS
b. If you click edit, the tiebreakers should be
1. Adjusted Ranks = win for lowest total cumulative rank points after
removing the highest and lowest rank points – increases fairness to
students by correcting for potential partiality or inconsistency in
judging pool
2. Total Ranks = win for lowest total cumulative rank points
3. Panel Ranks = win for lowest total cumulative room (panel)
rankings
4. Inverse Reciprocals = win for highest total from adding the
reciprocal point rank values (e.g. 1st is 1/1 = 1;
2nd is 1/2 = 0.5; 3rd is 1/3 = 0.33; 4th is 1/4 = 0.25;
5th is 1/5 = 0.2; 6th is 1/6 = 0.167; 7th is1/7 = 0.143; etc…)
5. Panel Reciprocals = win for highest total from adding the
reciprocal room ranking (panel) values (e.g. 1st is 1/1 = 1; 2nd is 1/2
= 0.5; 3rd is 1/3 = 0.33; 4th is 1/4 = 0.25; 5th is 1/5 = 0.2; 6th is 1/6 =
0.167; 7th is1/7 = 0.143; etc…)
NOTE: Breaking ties for speech events if two students are tied through all
tiebreakers – Speechranks requires each student to have a unique place of
finish. (Continued on next page.)
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Use the Show Power / Detail setting for the second and third rounds (if
there is a third round) and break the tie by giving the higher placement to
the student facing the more difficult competition. If tie is still unbroken,
then coin toss is used to break any unbreakable ties as Speechranks
requires each student to have a unique place of finish.

III.

Ballot Style
a. STOA Speech (w/ Penalties) - Interps, Platforms, and Monologue
b. STOA Speech (no Penalties) - Limited Preps (Apologetics, Extemp,
Impromptu, Mars Hill and Cold Reading)
IV. Leave NFL Type at Non-Qualifying
V. Speaker Goal – whatever number of students you most desire in each
panel
ii. Debate Events
I.

These debate tiebreakers are believed to be the best possible method for
debate tiebreaking (see full explanation in Section V at the end of this manual)
a. Previous tiebreakers meant teams facing the toughest competition were
often disadvantaged by earning lower Speaker Points and Ranks and
teams facing easier competition were advantaged by earning higher
Speaker Points and Ranks
b. Previous methods relied on the serial application of the three data
points collected (most often resulting in data points that were never
utilized)
1. Speaker Points
2. Speaker Rank
3. Opp W/L = Opposition Win vs Loss = Strength of Schedule
c. Teams with the highest Speaker Points were advantaged over the other
data points
d. Speaker Rank and Strength of Schedule (Opp W/L) were often not
considered
e. The new method applies all three data points at the same time utilizing
the previous tiebreaking pattern.
1. All three data points are ranked (similar to speech events) within
record brackets (e.g. 6-0, 5-1, 4-2 etc..) and then combined
giving each a one-third weighting

For local tournaments, changes may only be made to Tabulation methods described in this
manual (e.g. tiebreakers, power-matching process) if announced in writing on the tournament
registration website before tournament registration opens in keeping with the signed Stoa
Tournament Registration Form.

Stoa Joy of Tournaments Tabulation Manual

9

© Stoa

Rev 11/16

II. Tabulation Method – STOA.DEBATE
If the presets are not as listed, go back to the tournament set up under Admin ->
Properties -> Style Tab and unclick Stoa Tournament and click OK. Then go back to the
Style Tab and recheck Stoa Tournament and check OK. Stoa presets should now be
available for choosing. This process must often be followed if you are using data from a
previous tournament to set up a new tournament.

a. If you click edit, the tiebreakers should be
New Nomenclature added to Joy of Tournaments shown in Green.

1. Win/Loss = Ranked by Win vs. Loss record
2. STOA 2x Bracket Ranking Sum = STOA 2x Hi/Lo Points Bracket
Ranking + STOA 2x Hi/Lo Rank Bracket Ranking + STOA Opp
W/L Bracket Ranking
3. STOA Adj Bracket Ranking Sum = STOA Adj Points Bracket
Ranking + STOA Adj Rank Bracket Ranking + STOA Opp W/L
Bracket Ranking
4. STOA Bracket Ranking Sum = STOA Points Bracket Ranking +
STOA Rank Bracket Ranking + STOA Opp W/L Bracket Ranking
5. STOA Opp W/L Bracket Ranking = Ranks debaters with the same
win/loss record based on the win/loss records of their opponents
(measures strength of schedule)
6. Opp W/L = Opposition Win vs. Loss -- measures strength of
schedule with teams facing the better opponents receiving the
higher placement (note: this is the data used to calculate the
preceding STOA Opp W/L Bracket Ranking)
7. STOA 2x Hi/Lo Points Bracket Ranking = Ranks debaters within
the same Win/Loss record based on 2x Hi/Lo Points
8. 2x Hi/Lo Points = Highest placement to teams with best Speaker
Point totals (measured together as a team for each round) after
removing the two highest and lowest point totals – increases
fairness to students by rewarding the most consistent speakers
from round to round by eliminating points from rounds with
mismatched competition, preferential judging, or from judges who
over or under rate student Speaker Points relative to the general
judge pool (note: this is the data used to calculate the preceding
STOA 2x Hi/Lo Points Bracket Ranking)
9. STOA 2x Hi/Lo Rank Bracket Ranking = Ranks debaters with the
same Win/Loss record based on 2x Hi/Lo Rank
10. 2x Hi/Lo Rank = Highest placement to teams with best Speaker
Rank totals (measured together as a team for each round) after
removing the two highest and lowest rank totals – increases
fairness to students by rewarding the most consistent speakers
from round to round by eliminating ranks from rounds with
mismatched competition or preferential judging (note: this is the
data used to calculate the preceding STOA 2x Hi/Lo Rank Bracket
Ranking)

Stoa Joy of Tournaments Tabulation Manual

10

© Stoa

Rev 11/16

11. STOA Adj Points Bracket Ranking = Ranks debaters with the
same Win/Loss record based on Adj Points
12. Adj Points = Highest placement to teams with best Speaker Point
totals (measured together as a team for each round) after removing
the highest and lowest point totals – increases fairness to students
by rewarding the most consistent speakers from round to round by
eliminating points from rounds with mismatched competition,
preferential judging, or from judges who over or under rate student
Speaker Points relative to the general judge pool (note: this is the
data used to calculate the preceding STOA Adj Points Bracket
Ranking)
13. STOA Adj Rank Bracket Ranking = Ranks debaters with the same
Win/Loss record based on Adj Rank
14. Adj Rank = Highest placement to teams with best Speaker Rank
totals (measured together as a team for each round) after removing
the highest and lowest rank totals – increases fairness to students
by rewarding the most consistent speakers from round to round by
eliminating ranks from rounds with mismatched competition or
preferential judging (note: this is the data used to calculate the
preceding STOA Adj Rank Bracket Ranking)
15. STOA Points Bracket Ranking = Ranks debaters with the same
Win/Loss record based on Speaker Points
16. Points = Total Speaker Points (note: this is the data used to
calculate the preceding STOA Points Bracket Ranking)
17. STOA Rank Bracket Ranking = Ranks debaters with the same
Win/Loss record based on Rank
18. Rank = Total Speaker Ranks (note: this is the data used to
calculate the preceding STOA Rank Bracket Ranking)
NOTE: Coin toss is used to break any unbreakable ties as Speechranks requires
each team to have a unique place of finish.

II. Speaker Ranking Rules – STOA.SPEAKERS
a. If you click edit, the tiebreakers should be
1. STOA 2x Hi/Lo Ranking Sum = STOA 2x Hi/Lo Points Ranking +
STOA 2x Hi/Lo Rank Ranking
2. STOA Adj Ranking Sum = STOA Adj Points Ranking + STOA
Adj Rank Ranking
3. STOA Ranking Sum = STOA Points Ranking + STOA Ranks
Ranking
4. STOA 2x Hi/Lo Points Ranking = Ranks debaters based on 2x
Hi/Lo Points
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5. 2x Hi/Lo Points = Highest placement to student with best Speaker
Point total (measured for each individual student) after removing
the two highest and lowest points – increases fairness to students
by rewarding the most consistent speakers from round to round by
eliminating points from rounds with mismatched competition,
preferential judging, or from judges who over or under rate student
Speaker Points relative to the general judge pool (note: this is the
data used to calculate the preceding STOA 2x Hi/Lo Points
Ranking)
6. STOA 2x Hi/Lo Ranks Ranking = Ranks debaters based on 2x
Hi/Lo Rank
7. 2x Hi/Lo Ranks = Highest placement to student with best Speaker
Rank total (measured for each individual student) after removing
the two highest and lowest ranks – increases fairness to students by
rewarding the most consistent speakers from round to round by
eliminating ranks from rounds with mismatched competition or
preferential judging (note: this is the data used to calculate the
preceding STOA 2x Hi/Lo Ranks Ranking)
8. STOA Adj Points Ranking = Ranks debaters based on Adj Points
9. Adj Points = Highest placement to student with best Speaker Point
total (measured for each individual student) after removing the
highest and lowest points – increases fairness to students by
rewarding the most consistent speakers from round to round by
eliminating points from rounds with mismatched competition,
preferential judging, or from judges who over or under rate student
speaker points relative to the general judge pool (note: this is the
data used to calculate the preceding STOA Adj Points Ranking)
10. STOA Adj Ranks Ranking = Ranks debaters based on Adj Ranks
11. Adj Ranks = Highest placement to student with best Speaker Rank
total (measured for each individual student) after removing the
highest and lowest ranks – increases fairness to students by
rewarding the most consistent speakers from round to round by
eliminating ranks from rounds with mismatched competition or
preferential judging (note: this is the data used to calculate the
preceding STOA Adj Rank Ranking)
12. STOA Total Points Rankings = Ranks debaters based on Total
Points
13. Total Points = Total Speaker Points (note: this is the data used to
calculate the preceding STOA Speaker Points Ranks)
14. STOA Total Ranks Rankings = Ranks debaters based on Total
Ranks
15. Total Ranks = Total Speaker Ranks (note: this is the data used to
calculate the preceding STOA Speaker Rank Ranks)
NOTE: Breaking ties for debate events if two students are tied through all
tiebreakers – Speechranks requires each student to have a unique place of
finish.
The student with the better Win/Loss record shall be given the higher place
of finish. Coin toss is used to break any unbreakable ties as Speechranks
requires each student to have a unique place of finish.
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III. Ballot Style
a. LDV - “Debate – Ranks for LD” <– CHOOSE THIS!!!
b. TP – Default
c. Parli – Default
1. Remember for Parli -- under the Options Tab -- check the box
“Label Aff/Neg as Gov/Opp (Parli)”
IV. Leave NFL Type at Non-Qualifying
V. Speaker Points – Minimum 6, Maximum 30
VI. Duration (in minutes) – prints Flight times on Postings and Ballots
a. List the length of time of the first Flight in the Single Performance
window
b. Does not matter if Entire Round left at zero or filled in
VII. Speaker Goal – ignore as does not matter for debate
a. Non-flighted debate events will auto populate with “2”
b. Flighted debate events will auto-populate with “4”

D. Backing Up
1. Plan frequent backups to flash drives
2. You should have created a folder for the tournament when you originally saved the
tournament
3. Copy that entire folder with all the backups onto the flash drive
4. Joy will Auto-Save every 15 minutes and create a backup folder at whatever interval you
specify. The default setting is every 15 minutes
a. This means you are never have to recreate more than 15 minutes of work
5. Joy can be very particular about where you save your files
a. Be careful about your backing up and saving
b. Whatever file and folder you open the tournament from is the file location that will be
saved to
c. Where ever you last saved to is where all future saves and backups will go
6. Backup to the flash drive after every significant Tab event, e.g.,
a.
b.
c.
d.

After tournament set up, before entering or importing students
After sectioning and printing a round
After entering ballots for a round
Any other time there is some down time, be sure you are backed up
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7. “Save Copy As” allows you to save a separate copy to another file or location and to give
it an identifying name to make it easy to determine when the backup was made
a. Examples would represent progress in the tournament
i. Speech Round 2
ii. Speech Semis
iii. Debate Round 4
iv. Debate Quarters
v. Etc.
8. Have the tournament backed up to two different flash drives and have those carried by
two different people at the end of each day.

E.

Rooms
1. Right-click Add
a. Name
i. Try to keep it as short as possible as it improves the display
b. Notes
i. Any special notation, e.g. Tab, Judge Hospitality, Ballot Return
c. Times
i. Default is always available
ii. Availability can be specified
d. Checkboxes
i. Specify certain preferences
ii. Generally, uncheck all the boxes
iii. Not unchecking the boxes can lead to problems in Outrounds
e. Will alphabetize automatically, especially after a restart of the program.
2. General room scheduling concepts
a. Schedule the largest rooms for the best attended Speech Finals and Semifinals
i. Duo draws the largest crowd
ii. HI usually draws the next largest crowd
iii. Then OI, Expos, OO, etc…with the Limited Preps drawing the least
I. There may be regional differences in event popularity
II. Schedule based on what happens in your area
b. Schedule large rooms for debate Outrounds, especially the later rounds
c. Seek to minimize event movement
d. Plan Extemp Prep rooms to be near competition rooms
e. Plan for space for Expos paraphernalia, both for competition and storage
f. Plan for tournament administration rooms, e.g., Tab, Judge Hospitality, etc.

Stoa Joy of Tournaments Tabulation Manual

14

© Stoa

Rev 11/16

F.

Schools = Clubs
1. Right-click Add
2. Code
a. Three or four letters
b. Four letters generally offers better pattern recognition of the abbreviated name (Five
letters is too long and wont display properly on postings)
3. Name
a. Full name of the club
b. Try to keep to a single word or as short as possible (displays better on postings)
1. Match Club Names with those on Speechranks
a. Easiest during tournament set-up, but can be done before upload
to Speechranks
c. Enter any other information you wish

G. Sweepstakes – Pre-Tournament
1. Right-click on Event and Choose Sweepstakes.
2. General comments (represents the Sweepstakes philosophy of NITOC)
a. Should represent the “sweep” of the tournament
b. All speeches and debates should receive credit
c. A student should be rewarded for performing well on the first day of the tournament
as well as performing well on the last day of the tournament
i. More credit is earned as the tournament progresses to outrounds
d. Large events are mathematically more difficult to win
e. Large events can’t be given so much credit that the winner of a single large event
wins sweepstakes.
f. One method is to divide events up by size, e.g. small, medium, large and extra large
and decide how many points an event in each category is worth
g. Attempt to implement meaningful mathematical progressions
3. Speech Events
May count toward Speech Sweeps, Tournament Champion and Club Awards
For example:
a. Start with prelims – 100 minus 10 per place
i. 100 for 1st
ii. 90 for 2nd
iii. 80 for 3rd
iv. 70 for 4th
v. 60 for 5th
vi. 50 for 6th
vii. 40 for 7th
viii. 30 for 8th
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b. Semis – 200 minus 20 per place
i. 200 for 1st
ii. 180 for 2nd
iii. 160 for 3rd
iv. 140 for 4th
v. 120 for 5th
vi. 100 for 6th
vii. 80 for 7th
viii. 60 for 8th
c. Finals – 400 minus 40 per place
i. 400 for 1st
ii. 360 for 2nd
iii. 320 for 3rd
iv. 280 for 4th
v. 240 for 5th
vi. 200 for 6th
vii. 160 for 7th
viii. 120 for 8th
d. This arithmetic progression gives a balanced number of points for finishing 1st in
finals as it does for finishing 1st in both prelim rounds and semis combined.
i. If finals was scored 400, 390, 380, 370, 360… it would weight finals far to heavily
ii. Each place of finish in each round is given the same relative weight
Consider breaking your events down into category sizes like Extra Small, Small,
Medium, Large and Extra Large. Using NITOC 2012 as an example.
Extra Small
Wildcard
15 students

3 Prelims
Finals
Total

100 minus 10 per place
500 minus 50 per place
800 (if first place in every round)

Small
DI
Expos

43 students
48 students

3 Prelims
Semis
Finals
Total

100 minus 10 per place
400 minus 40 per place
500 minus 50 per place
1200 (if first place in every round)

Medium
Duo
HI
OI
Pers

63 students
70 students
64 students
65 students

3 Prelims
Quarters
Semis
Finals
Total

100 minus 10 per place
300 minus 30 per place
400 minus 40 per place
500 minus 50 per place
1500 (if first place in every round)

Large
Apol
Extemp
OO

109 students
104 students
96 students

3 Prelims
Quarters
Semis
Finals
Total

100 minus 10 per place
300 minus 30 per place
500 minus 50 per place
700 minus 70 per place
1800 (if first place in every round)
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Extra Large
Impromptu
222 students

3 Prelims
Quarters
Semis
Finals
Total

100 minus 10 per place
300 minus 30 per place
600 minus 60 per place
900 minus 90 per place
2100 (if first place in every round)

e. Copy Sweeps to other events of similar size
4. Debate Events
May count toward Debate Sweeps, Tournament Champion, or Club Awards
a. Plan for Total Points to match similar size speech event
b. Award points for all rounds (similar to all speeches)
At an Example Tournament
Points for Debate Wins/Losses
E.g., TP 64 teams and/or LDV 68 students = Medium Speech Event
Prelim Rounds x 6
30 points for win, 5 point for loss (just as with Speech, students
receive credit for participating in each round)
Total Prelim Points180 (if winning every round)
Quarters
200 points for reaching Quarters and 250 points for winning (or
reaching Semis)
Semis
350 points for win
(Awards 250 points for reaching Semis via points awarded for
winning Quarters)
Finals
500 points for win
(Awards 350 points for reaching Finals via points awarded
for winning Semis)
Total Points 1480 (if winning every round) Similar to the 1500 points for
a Medium size speech event.
Points for Speaker Awards - Must be calculated manually (demonstrated below), as not
currently supported in the software. Stoa has submitted
request to have this feature added to the Sweepstakes
calculations.
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TP 64 teams -> 128 Students = Large Speech Event
(Note that TP and Parli students are competing against twice as many
students as there are teams.)
1800 Points minus 180 per place
LDV 68 students = Medium Speech Event
1500 Points minus 150 per place
Tournament Champion at NITOC = Speech Sweeps Points + Debate Points + Speaker
Awards Points

H. Entering or Importing Students
1. If entering students manually, follow the instructions in the Joy of Tournaments manual
2. If importing using the Flowpad to Joy Converter, follow these steps
a. In Section B, you created three import files (saved as CSV files)
i. SpeechDebate Upload file for students in a single club
ii. Speech Upload file for students in separate speech club
iii. Debate Upload file for students in separate debate club
b. As mentioned earlier, if all students are only in one club, that file can be imported
directly into Joy without the necessity of the three separate files. Concatenate (combine
first and last name) the partner names first. Or use the Converter SpeechDebate tab to
automatically concatenate the names for you.
c. In Joy navigate to: File -> Administration -> Import -> Import Entries
i. Choose your CSV Upload files, importing them one at a time.
ii.
If using the three files, begin with the SpeechDebate Upload file
d. This brings up the Import Entries box allowing you to “Map” the data into Joy
i.
ii.
iii.
iv.
v.
vi.
vii.
viii.

ix.
x.

Student Last Name -> Last Name
Student First Name -> First Name
Speech Club -> School Name
Event Name (choose the actual event name) -> Event Name
1. Events can be mapped at one time, they don’t have to be done individually
Scroll down to the bottom of the left hand column
Duo Partner -> Duo Partner
TP Partner -> Team Policy Partner
Parli Partner -> Parliamentary Partner
I. Don’t use the Duo Partner First, Duo Partner Last or the Team Policy Debate
Partner First, Team Policy Debate Partner Last, etc. for mapping any of the
partnered events. Use the concatenated names (first and last names together)
further down on the list.
Click OK
Make sure student names are not all upper or lower case

Stoa Joy of Tournaments Tabulation Manual

18

© Stoa

Rev 11/16

e. Map the Speech Club to School Name for both the SpeechDebate import and the Speech
import
f. Map the Debate Club to School Name for the Debate import
3. Click on the Events folder, as this will list all events and the number of students entered into
each event. Verify that the number of students in each event matches the numbers in your
tournament registration page. If not, figure out why.
4. In team events, such as Duo, Parli, and TP make sure the teams are all matched correctly.
There should not be any singe person teams. Refer to the Joy manual on how to correct
unmatched teams
5. Sometimes the students on the team are not listed alphabetically. They should be.
6. Right-click on team and select Change Team.
7. Change the team name for alphabetical correctness.
8. If two or more sets of siblings are partnered in Duo, Parli or TP, add a first initial directly in
front of the last name, e.g. two or more sibling with the team name of Smith-Jones. Andrew
Smith and Janet Jones become ASmith-JJones and Kathy Smith and Robert Jones become
KSmith-RJones
a. This convention will allow for the proper displaying of names in Speaker Results for
debate. Other methods of adding initials will result in improper displaying of names.
9. Double check all of your tournament setup
a.
b.
c.
d.
e.
f.
g.
h.
i.

I.

Events
Rounds
Dates and times
Rooms
Students
Expected sections
Sweepstakes
Clubs
Tabulation

Sectioning Speech Events
1. Print copies of the Tab Speech Workflow Tracking Sheet - http://stoausa.org/help-files/
a. This will make sure that you perform all the necessary tasks for each event throughout
the tournament.
i. It is remarkable how easy it is to forget basic tasks.
ii. Not every checkbox needs to be completed for every round

Stoa Joy of Tournaments Tabulation Manual

19

© Stoa

Rev 11/16

2. Right-click Event Round One and choose Create Sectioning
a. This sections all the preliminary rounds for the event at one time.
3. Right-click Event Round One and choose Adjust for Cross Entries
a. This moves students entered in multiple events to speaker positions that increase the
likelihood of the students completing each of their speeches in a particular pattern.
b. A checkbox will appear. Choose the events in a particular pattern.
c. If you have manually adjusted the Extemp speaker positions (mentioned below), then do
not check the box for Extemp, or your work will be undone.
4. Perform the Section Check
a. The program will alert you to several potential issues if they exist
i. Ignore the warning that “Students from the same school are speaking back to back.”
This is not something to be concerned about. (It is an issue in college)
ii. Number of students in each section (room) should be balanced to within one
iii. Make room changes for students with special needs
iv. Extemp students from same club should not be in the same speaker position (This is
less of an issue now that many clubs are using Electronic Extemp, but seeking to
minimize is still a good idea.)
I. Joy automatically performs function
a. Right-click on the Extemp Round in the left window pane
b. Select “Speaker Order” from the drop down menu
c. Click the “PRP Extemp” button and click OK
1. Depending on the number of conflicts, this procedure may need to
be performed repeatedly.
i. May not work and may need to be performed manually
2. You may need to select another event in the same pattern to cause
this to work.
II. Manual method
a. Hover the mouse over any student and all students in the same club
turn red
b. Students can be moved by clicking and holding the mouse and then
moving the student to the desired location and releasing the mouse.
c. Perform this activity carefully as there is no “undo” button
5. Build Anonymous Judge Panel by right-clicking on Section One of each event.
a.
b.

Choose “Build Anonymous Panels” from the drop down menu
This will anonymously panel the number of judges you specified in the event set up for
each of the Prelim Rounds. If not, repeat this procedure on subsequent Prelim Rounds
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6. Make any Final Room Adjustments
a.

Make any necessary room changes
i.
Examples might include for students with special needs. This might be a student
confined to a wheel chair or a student that is injured and on crutches. Do not
assign these students to an inaccessible room such as a second floor room in a
building without an elevator.

7. Tab Director performs any necessary quality control
a. The Tab Director should review any of the steps performed above as needed based on
any problems or difficulties experienced by the tabulation team
8. Print Ballots
a.

Right-click on event round

b.

Choose “Print All Ballots” from the drop down menu

c.

Print on the back of the pre-printed ballots for the event
i. This will create the Judges Ballot on one side and the event rules will be on the
other side

9. Print Postings
a.

Right-click on event round
i. Choose “Print Postings” from the drop down menu

b.

You may choose to print the large postings from the “Posting – Large” folder under the
round. These are easier to read.
i. Right-click in the right window pane and choose to “Print on Default Printer” for a
single copy or “Print…” to specify the printer and number of copies.

c.

Keep a copy for Tab.

Sibling Protect – As with the concept of Club Protect (addressed later in the debate section), Sibling
Protection (preventing siblings from speaking or debating against one another) depends on the
tournament’s philosophy. There is no right or wrong answer to these choices, just different preferences.
There are valid arguments to be made for both options. One side can reasonably support the decision not
to have siblings compete against one another at a tournament. The other side recognizes that creating
any form of protection advantages some students/families and can also create disadvantages for other
students/families.
NITOC – there is no Sibling Protection at NITOC (beyond that provided by club diversification in
Speech and Club Protect in preliminary rounds of debate).
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J.

Debate Pairing
1.

Print copies of the Tab Debate Workflow Tracking Sheet – Preliminary Rounds
http://stoausa.org/help-files/
a. This will make sure that you perform all the necessary tasks for each event throughout
the tournament.
i. It is remarkable how easy it is to forget basic tasks.
ii. Not every checkbox needs to be completed for every round.

2.

Random Rounds
a. Right-click on the round to be paired
b. Random tab – At least first round
c. Method – Normal
d. Side Assignment – Balanced
i.
ii.

The software will attempt to assign each team an even number of
Affirmative (Government) and Negative (Opposition) rounds in a tournament
with an even number of preliminary rounds (strongly recommended)
An even number of rounds on each side of the ballot is a priority which will only
be violated in rare cases as noted on Page 25 in J.4.b.

e. Priorities (these might need to be altered for events heavily populated by one or more
clubs or for very small tournaments)
i. Squad Mates (teams from same club) – Also known as “Club Protect”
I. Absolute - prevents teams from the same club debating one another
II. Preferred - allows teams from same club to debate, but only if necessary
III. Ignore - ignores club affiliation allowing teams from same club to debate
IV. This choice depends on the tournament’s philosophy of whether or not to
allow teams from the same club to debate one another. There is no right or
wrong answer to these choices, just different preferences. There are valid
arguments to be made for both options. The impact of this choice is much
more significant in power matched rounds as will be discussed in that
section of this manual.
a. The main argument for offering Club Protect is to require students
to debate teams from other clubs and not to debate their own
teammates against whom they may practice on a regular basis.
There are also issues of club spirit and camaraderie.
b. The main argument against offering Club Protect is that any form
of protection alters the true random nature of the debate round by
increasing the probability that teams from larger clubs will not
debate one another. This advantages larger clubs and
disadvantages smaller clubs.
c. Some feel the Preferred option is a reasonable middle ground.
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ii.
iii.
iv.

3.

Prior Opponents – Absolute (obviously not applicable to Round 1)
School (Club) Variation – Preferred
Squad (Club) Variation – Preferred

f.

Double-check Side Assignment again. The program default is Absolute and sometimes
after initially choosing Balanced the program will default back to Absolute after
making the Priorities choices in the previous step

g.

Click “Create Pairings” button

Power Matched Rounds
a. The sooner, the better as students are matched against those of like ability and the
validity of the results increases. (Small tournaments may need to delay power matching
or not use power matching if the event is very small.)
b. Right-click on round -> Pair
c. Hi-Low Power Match tab
d. Use Rankings as of: the round you are Power Matching off of
e. Bracket Balancing
i. Promote – Worst Opposition
I. Moves the team least deserving of their record to the higher bracket
II. This is the fairest method present in any debate software
ii. Placement – Recalculate
I. Pairs the round within the bracket as if all teams share the same record
II. Provides balance to potential uneven pairings increasing fairness
f. Options
i. Prevent squad-mates from hitting
I. Checking the box will keep teams from the same club from debating one
another
a. Even if desired, may need to be unchecked for events heavily
populated by one or more clubs or for small events as program
may not be able to power match the later rounds
b. A helpful tip if utilizing power matching at a tournament with more
than about 30% of the teams from one club is to place all of the
teams from the large club on aff / gov or neg /opp in Rounds 3 and
5. That will increase the chance of better power matching in
Rounds 4 and 6.
II. Unchecking the box will allow teams from the same club to debate one
another

Stoa Joy of Tournaments Tabulation Manual

23

© Stoa

Rev 11/16

III. This choice depends on the tournament’s philosophy of whether or not to
allow teams from the same club to debate one another. There is no right or
wrong answer to these choices, just different preferences. There are valid
arguments to be made for both options. The impact of this choice is more
significant in power matched rounds as it has a greater impact on which
teams debate each other in power matched rounds
a. The main argument for offering Club Protect is to require students
to debate teams from other clubs and not to debate their own
teammates against whom they may practice on a regular basis.
There are also issues of club spirit and camaraderie.
b. The main argument against offering Club Protect is that any form
of protection alters the debates that “should occur” based on the
power matching algorithm increasing the probability that teams
from larger clubs will not debate one another. This advantages
larger clubs and disadvantages smaller clubs.
c. Analysis of the impact of club protect at NITOC indicates that in
each round about 25% of the students will be moved to a debate
other than the one the program would have chosen as the best
power match. (This is the largest debate tournament with the
greatest number of teams. It is expected that at smaller
tournaments with fewer teams that the impact will be far greater.)
There are still valid arguments for altering the power matching by
club protecting, but the tabulation staff (and tournament attendees)
must be aware that any form of protect advantages some
teams/clubs while disadvantaging others. The question becomes
one debated in every round…which advantages and disadvantages
will be considered the most important.
ii. Prevent prior opponents from hitting
I. Check
iii. Adjust pairings to hide power
I. Uncheck
a. This allows you more easily review the power matching
i. It is recommended to review the power matching
b. If you forget and leave this checked when you Create Pairings you
can right-click in the right window pane and choose Show
Seedings to reveal the same information
iv. Click “Create Pairing” button
4.

Check for any error messages
a. Generally, do not worry about a message that “power matching failed.” It just means
the strictness of your criteria was not completely met. The round is probably okay.
Most commonly this means teams have been “pulled-up” from their brackets to
debate teams with better records.
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b. The program prefers better power matching at the rare expense of the lowest ranked
debaters, e.g. a low ranked team might be given an extra aff /gov or neg/opp round in
the final round to improve the power matching to determine who breaks and who
does not break. This means the program prefers debates that “matter” in terms of
breaks over those debates that do not factor into the break decision matrix.
5.

Check validity of pairings
a. Review seedings and power matched pairings
i. If “adjust pairings to hide power” was unchecked then seedings will display
ii. If not unchecked then right-click in right window pane and choose Show
Seedings – this can be done anytime you wish to view the seedings and the
power matching
b. Review the win/loss records of paired teams
i. Ideally, teams with the same records should be paired against each other.
I. E.g., the 4-0 teams should be paired against other 4-0 teams. The 3-1 teams
should be paired against each other and the 2-2 teams should be paired
against each other. However, the program can rarely pair teams in this
manner perfectly. Often, the program will “pull-up” a 3-1 team to debate a
4-0 team or “pull-up” a 2-2 team to debate a 3-1 team, etc. This is called a
“pull-up”. Rarely, the program will need to “pull-up” a 2-2 team to debate a
4-0 team. This is called a “double pull-up.” Pull-ups are relatively common
so do not be alarmed when they occur.
II. By choosing earlier to promote the team with the worst opposition record it
helps to minimize the number of times an individual team will be pulledup. The pulled-up team is credited for having faced a team with a better
record and this decreases the likelihood the same team will be pulled up
repeatedly.
a. When lag power matching (power matching off a round previous to
the immediate prior round) the chances of a team getting pulled up
again increase as the program is using data from an round previous to
the last round competed.
c. Check that a student/team is not assigned two Bye rounds
i. No team should be given two automatic wins
ii. The program will likely only make this happen if lag power matching, but be
sure to check for a second Bye in each round
d. Check that a student/team is not assigned a Bye that has a prior win by forfeit or that
a team will be receiving a forfeit (if known) if they have a previous Bye
i. No team should be given two automatic wins
e. Uncheck Show Seedings (right-click in the right window pane) prior to printing
ballots and postings
i. Failure to do so will show the current won/loss records of the teams
ii. The Show Seedings can be turned on and off anytime you wish to view the
seedings and the power matching

Stoa Joy of Tournaments Tabulation Manual

25

© Stoa

Rev 11/16

6.

Re-Order Pairings
a. Right-click in right window pane and choose Re-Order Pairings. Choose Random
and click OK.
i. This step is important because it hides the brackets so the students cannot
determine who has what record.
ii. If not done, the posting will essentially show students records

7.

Double Flighting of LDV
a. It is often preferable to have students from the same club in the same room in back to
back rounds.
i. This improves the percentage of rooms that judges can judge
b. Joy will perform this function automatically
i. Choose each Round being Double Flighted prior to printing ballots or postings
ii. Right-click in the right window pane, but do not click on or between a debate
pairing, e.g. click above or to the right of the debate pairings
iii. Choose “Re-Order Pairings” from the drop down menu
iv. Choose “Minimize schools per flight” and click OK
v. This will place students from the same club in the same room in Flight One and
Flight Two (obviously in separate Flights)
vi. Remember that when double flighting you are essentially re-ordering the pairings
twice by first choosing Random and then again choosing Minimize schools per
flight

8.

Make any Final Room Adjustments
a. Make any necessary room changes
i. Examples might include for students with special needs. This might be a student
confined to a wheel chair or a student that is injured and on crutches. Do not
assign these students to an inaccessible room such as a second floor room in a
building without an elevator.

9.

Tab Director performs any necessary quality control
a. The Tab Director should review any of the steps performed above as needed based on
any problems or difficulties experienced by the tabulation team.

10. Print Ballots
a. Right-click on the Round -> Debate Ballots
b. Choose “Stoa Ballot” from the Ballot Format window
c. Print on the front of the pre-printed debate ballots for the event
i. Be sure to move all Sections from the left window to the right window
ii. Click the button to print in Section order
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d. Right-click on the Round -> Debate Ballots
e. Choose “Stoa Speed Ballot” from the Ballot Format window (if using – this helps
tournaments run on time, especially useful at large events)
i. Be sure to move all Sections from the left window to the right window
ii. Click the button to print in Section order
11. Print Postings
a. Right-click on the Round -> Print Postings
i. Or print from the view of the round itself in the right window pane
b. Keep a copy for Tab

K. Speech - Entering Ballots
1. Find Round, Section, and Judge then right-click and Enter Ranks
a. Maximum rank entered should equal the smallest panel (number of students in room)
regardless of how many students are in the larger panels
i. E.g., smallest panel has 7 students, so larger rooms are tabbed 1,2,3,4,5,6,7,7
2. Do this for all judges
3. Ballot status can be checked by viewing Ballot Status
4. ALWAYS, ALWAYS, ALWAYS have two people work together to input results
a. NEVER allow one person to read results and enter data as this is the surest way to
introduce error into the recording of results.
b.

One person reads ballot and second person keys in results
i. Reader reads list of names to confirm speaker order on printed ballot matches the
speaker order on the screen
ii. Reader reads numbers from top to bottom of Judges Ballot
iii. Data entry person then reads the numbers back from bottom to top

5. Double Checking Results (previously known as Shadow Tab)
a. For each Round of each event navigate to the folder labeled Results by Section
i. Print these results
I. Double check these results against the ballots
II. Again, have one person read the ballots and another person confirm the
results on the printed page
III. If the same two people are performing the Double Check as originally
entered the data, then they must switch roles.
a. The person who originally keyed in the data should be the one to read the
ballots.
b. The original ballot reader should NEVER re-read ballots during the
Double Check as any mistakes made the first time are at risk to be
repeated.
Stoa Joy of Tournaments Tabulation Manual

27

© Stoa

Rev 11/16

IV. Do not perform this activity on screen, use a paper printout of the Results by
Section
6. Tab Director Performs any necessary quality control
a. The Tab Director should review any of the steps performed above as needed based on
any problems or difficulties experienced by the tabulation team

L.

Debate - Entering Ballots
1. Can be done by viewing the round and right-clicking on the individual debate and choosing
to Enter Ballot
2. Preferred method is to right-click on the round and choose Enter Ballots
3. This brings up all the ballots and you can choose the ballot to enter
4. Confirm teams for Aff (Gov) / Neg(Opp)
a. Vitally important during outrounds as Tab team places teams on appropriate sides based
on coin flip in rounds.
b. Make sure the correct team is assigned the W/L and not just the Aff (Gov) or Neg (Opp)
5. Just type in the numbers as indicated for Speaker Points, Rank and Decision
a. No tabbing (using the tab key) is necessary as long as the Speaker Points are 10 or
greater. The software will automatically move the entry point from one field to the next.
Tab Key is needed if Speaker Points are 6 to 9 to advance to the next field.
6. For Bye rounds, make sure the opponent is listed as BYE
a.

Speaker points and ranks will be averaged

7. Forfeit Rounds
a. Winning team will have speaker points and ranks averaged
i. The Results for the round will show “0” and the Check Sheet will show no numbers
(only the decision) and neither will reflect the averaging of points on these screens.
Review the Prelim Results file and this should reflect the averaging. If not, go back
and double-check the data entry.
b. Forfeiting team will have zero speaker points and ranks will be recorded as “2” for LDV
and “4” for TP and Parli
c. If a team/competitor has already received a win from a forfeit, do not let them receive a
bye.
i. This would give the team two wins without having to debate to earn both wins.
ii. The speaker points should still calculate correctly, but double check to be sure.
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d. If a team has already received a bye and then is going to receive a forfeit, try to re-pair
the round to prevent this from happening.
i. If there is no time to re-pair the round, there is nothing else to do except to record
the results accurately.
e. There must be an opposing team in forfeit rounds
i. DO NOT attempt to assign a forfeit to a Bye round.
8. Handling Speaker Results for teams that drop during preliminary rounds at the tournament
a. Make sure these students finish last in the Speaker Results uploaded to Speechranks as
they did not compete fully through all rounds determining speaker placings.
i. This may need to be done manually on the CSV produced by Joy.
9. ALWAYS, ALWAYS, ALWAYS have two people work together to input results
a. NEVER allow one person to read results and enter data as this is the surest way to
introduce error into the recording of results.
b. One person reads ballot and second person keys in results
i. Reader reads numbers and decision from the ballot
ii. Make sure the correct team is assigned the W/L, Speaker Points, Speaker Ranks and
not just the Aff (Gov) or Neg (Opp)
iii. Data entry person then reads the numbers and decision back
10. Double Checking Results (previously known as Shadow Tab)
a. For each round of the event navigate to the folder labeled either Results or Check Sheet
i. Print these results
I. Some folks prefer one of the display styles over the other
II. The information should be the same between the two folders
a. Very rarely during tournament set up the names of the debate partners
may be switched to correctly alphabetize their names. Depending on
how the data was input into the program, this could, on rare occasion,
result in the switching of Speaker Points and Speaker Rank amongst
partners.
1. This is another reason a double check is performed
2. If this happens, check the other display format from the other
folder (Results vs. Check Sheet) and see if the results are correct in
the other folder. If so, then use only that folder format for the
remainder of the tournament.
III. Double check these results against the ballots
a. If Speed Ballots were used for original ballot entry, use the regular
Stoa Ballot for the double check
IV. Again, have one person read the ballots and another person confirm the
results on the printed page
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V. If the same two people are performing the Double Check as originally
entered the data, then they must switch roles.
a. The person who originally keyed in the data should be the one to read
the ballots.
b. The original ballot reader should NEVER re-read ballots during the
Double Check as any mistakes made the first time are at risk to be
repeated.
VI. Do not perform this activity on screen, use a paper printout of the Results or
Check Sheet
11. Tab Director performs any necessary quality control
a. The Tab Director should review any of the steps performed above as needed based on
any problems or difficulties experienced by the tabulation team.

M. Speech Breaks to Outrounds
1. Go to Event, Prelim Results, Anonymous
a. Do not look at the Prelim Results with names before clicking into the Anonymous
folder so as not to be influenced by the names on the list
b. Decide how many students to advance to Outrounds and ensure that there are no ties
between breaking and non-breaking students
c. Write the number down of anonymous students who will advance
d. Return to Prelim Results and Double-click under the number of students to be advanced
2. Sectioning
a. Right-click on the first outround and choose Create Sectioning
b. Verify the section data for the number of qualifiers, sections and speakers per section
c. For Method choose Balance Power for all outrounds except Finals. For Finals choose
Default.
i. For all Outrounds do not check the box for Top/Bottom Speaker Order
3. Perform the standard Section Check as on Page 20 I.4. including the Extemp check as in
I.4.a.iv.
a.

If a student breaks to Outrounds in Extemporaneous and many other speech events it
can be helpful to place the student(s) in one of the first speaking slots in the
Extemporaneous section. This will maximize the opportunity for the student(s) to
present all of his/her speeches within the time frame allotted for the Outround. This
also minimizes wait times for judges and decreases the risk of tournament delays.
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4. Club balancing in Outrounds while maintaining power balance
a.

Performed automatically by the software

b.

Right-click between the Sections (in the right window pane) and choose Show
Power/History

c.

This show the balance of power in the rooms (as well as giving additional information
as documented in the manual produced by Joy of Tournaments)

5. Proceed to the round to be competed and complete all the same tasks as previously
documented beginning on Page 20, I.5 through Page 21 I.9 to build panels, make final
room adjustments, Tab Director quality control and to print ballots and postings.
6. TAB DIRECTOR should confirm correct qualifiers to Outrounds.

N. Speech Breaks to Next Outround
1. Tabulate the round
2. Right-click on the round just tabulated and choose Break to “Name of Next” Round
a. This will prompt you to enter the number of students from each section to be advanced
to the next round
b. Fill in the appropriate number
3. Right-click on the next Outround to be competed and choose Create Sectioning
a. Verify the section data for the number of qualifiers, sections and speakers per section
b. For Method choose Balance Power for all outrounds except Finals. For Finals choose
Default.
i. For all Outrounds do not check the box for Top/Bottom Speaker Order
4. Perform the standard Section Check as on Page 20 I.4. including the Extemp check as in
I.4.a.iv.
a. If a student breaks to Outrounds in Extemporaneous and many other speech events it
can be helpful to place the student(s) in one of the first speaking slots in the
Extemporaneous section. This will maximize the opportunity for the student(s) to
present all of his/her speeches within the time frame allotted for the Outround. This also
minimizes wait times for judges and decreases the risk of tournament delays.
5. Club balancing in Outrounds while maintaining power balance
a. Performed automatically by the software
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b. Right-click between the Sections (in the right window pane) and choose Show
Power/History
c. This show the balance of power in the rooms (as well as giving additional information
as documented in the manual produced by Joy of Tournaments)
6. Proceed to the round to be competed and complete all the same tasks as previously
documented beginning on Page 20, I.5 through Page 21 I.9 to build panels, make final
room adjustments, Tab Director qualify control and to print ballots and postings.
7. Repeat this process until the tournament is finished
8. TAB DIRECTOR should confirm correct qualifiers to subsequent Outrounds

O. Debate Breaks to Outrounds
1. Print copies of the Tab Debate Workflow Tracking Sheet – Outrounds
http://stoausa.org/help-files/
2. Navigate to the Prelim Results folder for the event and open that folder
3. Right-click on Seedings and choose Create Seedings
4. Right-click on Seedings again and choose Seed Bracket or Seed Partial Bracket
a. If your tournament is competing a Partial Outround bracket the software will ask
how many teams will be advanced to Outrounds
b. Fill in the appropriate number
5. Proceed to the specific Outround to be competed, E.g. Quarterfinals, Semifinal, Finals,
etc.
6. Create judge panel
a. Right-click on the specific Outround and choose Build Anonymous Panels
7. Hide Seedings and Bracket
a. Navigate to the Judges folder for the specific Outround
b. Right-click in the right window pane and un-click Show Seedings
c. Right-click in the right window pane and check “in Aff Code Order”
i. The default setting of “in Section Order” displays the debate bracket
ii. Utilizing “in Aff Code Order” makes it harder for debaters to determine seeding
and the bracket
8. Make any necessary room changes
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9. Print Ballots and Postings
a. Print Speed Ballot and Student (Regular) Ballot as during preliminary rounds
b. To print Outround Postings navigate to the Judges folder for the Outround and
Right-click in the right pane and choose Print
i. The Judges folder gives a better format for printing for judges sign up at Ballot
Push
ii. Do not right-click on the Outround name and choose Print as was done in
Preliminary rounds as doing so will cause the bracket to print
10. When entering ballots for a partial round, make sure that the teams receiving a Bye are
given a win. Sometimes they may not advance correctly if you don’t complete this step.
a. The software may indicate that the ballot could not be recorded, that is okay
11. Entering Ballots must be performed with extreme caution as sides are not assigned except
in cases where teams have previously met and sides are locked
a. Check and double check that sides are correct
b. Print results and double check results
c. THE TAB DIRECTOR SHOULD PERSONALLY TRIPLE CHECK RESULTS
13. Continue repeating the same tabulation process until the event is complete
14. Speaker Points and Speaker Rank are not recorded in Outrounds

P.

When the Event is Complete
1. Event should show as Complete when it is finished
2. All events should be complete – if not right-click Event -> Complete

Q. Sweepstakes – Post-Tournament (All of these are optional)
1. Review results to make sure they “look right”
2. Picket Fence Awards
a. Given to students earning the most Picket Fence Rounds
i. Meaning all judges on a panel rank the student first
b. Keep track while entering ballots or review results in Joy
3. Speech Sweepstakes
a. Sweeps Folder and choose Individual Folder
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4. Tournament Champion
a.

One method is to use the Speech and Debate Sweeps from Joy

b.

Another method is to sum Speech Sweeps + Debate Points + Speaker Award Points
(this is the NITOC method)
i. Speech and Debate Sweep Points come from Joy
ii. Speaker Award Points scored manually
I. Explained in Section G, “Sweepstakes,” Page 15

5. Club Awards (Club is defined as having three or more students)
a. Speech Awards
b. Debate Awards
c. Club Champion Awards
i. A “Club” must have a minimum of three students for NITOC
d. For all Club Awards use the Club Champion Spreadsheet http://stoausa.org/help-files/
i. Enter all Clubs
ii. Enter the number of Speech students per club
iii. Enter the number of LDV students per club
iv. Enter the number of Parli teams per club
v. Enter the number of TP teams per club
e. The Club Champion Spreadsheet balances and compares large clubs with small clubs
based on standardized scores for both total points and club efficiency
f. The number of students in LDV vs. Team/Parli Debate events is also considered
g. The Standard Rank column shows the order of finish
h. The Percent Rank column is used as a tiebreaker

R. Create Awards Script
1. Two to three hours from the end of Speech finals is recommended before the tournament
results are needed on stage
a. Depends on the complexity of the awards to be presented
b. Use results from program
2. Navigate to Final Results at the bottom of each event folder
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3. Alternatively, use the Tournament Results produced by Joy
a.

S.

File -> Administration -> Export -> Export Results
i. Produces a CSV file for each event
ii. Note: Speaker Awards can be completed after prelims

Compiling Results for Review and Distribution
1. Combine the CSV files into one spreadsheet file

T.

a.

Drag and drop the events onto a common spreadsheet file

b.

Arrange in alphabetical speech order and the alphabetical debate order

c.

Save as an Excel file as CSV files only allow a single sheet (tab)

d.

Email to interested parties

Upload to National Christian Homeschool Speech and Debate Rankings
1. Browse to www.speechranks.com
2. Register yourself on the site and click, “I am not a competitor.”
3. Create a Tournament
a. Enter all tournament information
4. Create a Flag on the Tournament and request Tournament Access
5. Speechranks Administrators will grant you access to your tournament
6. This provides you the ability to Upload tournament results
The following information is posted on the Speechranks website:
Information Needed for Tournament Administrators to
Upload Tournament Results
http://www.speechranks.com/about/uploading_results
7. Joy of Tournaments produces CSV files for each event for upload to Speechranks
(Speechranks requires CSV files for uploading tournament results)
a. File -> Administration -> Export -> Export Results
i. Produces a CSV file for each event saved in the same folder as the tournament
files or wherever you specify when saving
ii. These CSV files can be uploaded to Speechranks
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b. Debate Speaker Results must be obtained separately by another means
i. Navigate to each Debate Event -> Prelim Results -> Speaker Points
ii. Then right-click in the right window pane (the window with the Speaker Points
results) and choose “Save Speaker Rankings as Text…”
I. The text file (noted as a TXT file) will be saved in the same folder as the
other tournament files or wherever you specify when saving
iii. Use Excel to convert the TXT file to a CSV file
I. Open the .txt file from within Excel using the “Open” command
II. This should launch the Text Import Wizard
a. You can also choose “Import” from the File menu and Excel will ask,
“What type of file do you want to import?”
b. Choose the Text File button and click Import
c. Navigate to the text file you want to use and select it and click Get
Data (or whatever the prompt is for your version of Excel)
d. This should also launch the Text Import Wizard
e. If your version of Excel does not offer this functionality then ask one
of your Excel savvy friends to help you
III. In the “Original Data Type” window choose the “Delimited” button
IV. Set “Start Import at Row” to 3 (or to whatever row shows Rank, Code,
Name… or Rank, School, Team…etc.) and click Next
V. In the Delimiters window choose “Comma” and click Next
VI. In the Column Data Format window the “General” button should be
checked. Click Finish
VII. Only the Rank and Name columns will be needed for uploading to
Speechranks. You do not need to delete the other columns; you can simply
choose the two necessary columns when uploading to Speechranks.

U. Merging the Tournament when Using Multiple Computers
1. Divide the tournament up into separate workstations
a. Speech, LDV, Parli, TP
i. Speech can be further divided up within each pattern to quicken ballot entry
b. Save the tournament to a flash drive
c. Take flash drive to master computer
d. From master computer choose File -> Administration -> Merge Tournament
e. In the Locate Box click Browse
f. Find the tournament file you will import and chose Open or double-click
g. Click Next
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h. Map the event from the Current Tournament window to the same event in the
Imported Tournament window
i. Repeat this for all events you are merging
Congratulations on a job well done!
For from Him and through Him and to Him are all things. To Him be the glory forever. Amen.
Romans 11:36 (NASB®
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V. Stoa Debate Tiebreakers (A Better Understanding)

Stoa Debate Tiebreakers
Stoa has developed a comprehensive tiebreaker system to fairly rank debaters. The current
model eliminates various problems and increases fairness. Our tabulation software (Joy of
Tournaments) utilizes this tiebreaker system.
The old tiebreaker system (pre-2015) had weaknesses that failed, at times, to reward debaters
appropriately. For example, consider the following real life example that often occurred under the old
tiebreaking method. Team A and Team B participate in six preliminary rounds of debate and both teams
finish with 4-2 records. Team A won their first four debates and lost the next two debates. Team B lost
their first two debates and won their next four debates. Because of power matching, the teams competed
as follows:
After Round 1
Team A is 1-0

Team B is 0-1

Round 2
Team A debates another 1-0 Team and wins

Team B debates another 0-1 Team and loses

Round 3
Team A debates another 2-0 Team and wins

Team B debates another 0-2 Team and wins

Round 4
Team A debates another 3-0 Team and wins

Team B debates another 1-2 Team and wins

Round 5
Team A debates another 4-0 Team and loses

Team B debates another 2-2 Team and wins

Round 6
Team A debates another 4-1 Team and loses

Team B debates another 3-2 Team and wins

After Round 6
Team A is 4-2

Team B is 4-2

Team A is a good Team and received middle of the road Speaker Points because it debated
strong opponents who were also good speakers. Team B is a good Team and collects excellent Speaker
Points because it debated weaker opponents who had weaker debating skills. Team B earned more
Speaker Points than Team A because Team B looked better in comparison to its less accomplished
opponents than Team A looked in comparison to their more successful opponents. Nevertheless, the old
tiebreaker system would place Team B above Team A in the tournament standings. There were
tournaments where the old tiebreakers would break the 4-2 tie based on Speaker Points and, therefore,
Team B would advance to outrounds (not Team A) because Team B received higher Speaker Points
(which Team B earned by defeating weaker teams).
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However, based on the records of their opponents, Team A faced much tougher competition than
Team B. In rounds 2-6, Team A debated an opponent with a winning record in every round (1-0, 2-0,
3-0, 4-0, and 4-1) but Team B debated only one opponent in rounds 2-6 with a winning record (a 3-2
record). All the other opponents of Team B had losing or neutral records (0-1, 0-2, 1-2, 2-2).
In addition, the combined the records of all the opponents of Team A, at the time they debated
Team A was 14 wins and 1 loss. Team B, on the other hand, debated teams that, at the time of each
debate with Team B, had a combined total of 6 wins and 9 losses.
This stark imbalance in the degree of competition faced by Team A and Team B was troubling
because, under the old tiebreaker system, Team B would finish ahead of Team A and could be advanced
to outrounds (not Team A) based on Speaker Points.
This scenario occurred repeatedly using the previous tiebreaking methods and it raised
important fairness questions.
Was Team A treated fairly from a tiebreaking perspective?
Which team was more deserving of the 4-2 record?
Should Team B advance to outrounds after debating significantly weaker opponents?
Should Team B be rewarded for collecting better Speaker Points against weaker opponents?
As a result, Stoa Tab was not satisfied that the debate results produced using the previous
tiebreaking methods were as fair as they could be or even fair at all. Stoa Tab was convinced that a
superior method of tiebreaking was needed and could be developed. When considering tiebreakers, Stoa
Tab believes that each of the data points produced during the round should be used. Specifically, each
round produces four data points:
a.
b.
c.
d.

The Win/Loss record of the debate team
Speaker Points
Speaker Rank
Strength of Schedule: the combined Win/Loss records of all opponents of a debate team

The first basis for ranking debaters is always the Win/Loss record. Initially ranking debaters
based on their own Win/Loss records is universally agreed upon. Thereafter, tiebreakers are a matter of
tab philosophy. There are no right or wrong tiebreakers, but Stoa Tab does believe in the method
adopted (discussed below) and will advocate for the tiebreakers currently in use.
Stoa Tab has produced what many believe to be the fairest tiebreaking method available. The
Stoa Tiebreakers were produced by the combined work of the NITOC Tab Directors with input from
other Tab Directors. The Stoa Tiebreakers are available only in Joy of Tournaments thanks to special
computer programming for Stoa. Other debate software only offers the old tiebreaking methods
producing the problematic results detailed previously.
After grouping teams into Win/Loss brackets (e.g. 6-0, 5-1, 4-2, 3-3, 2-4, 1-5, 0-6) the question
becomes how to determine where each team places within the bracket. What should be the tiebreakers
for distinguishing between the 6-0 teams, the 5-1 teams, the 4-2 teams, etc.? This placement will
determine a team’s final place of finish at a tournament and may determine which teams advance to
outrounds and which teams do not.
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The old tiebreaking methods relied upon the serial application of the remaining three data points:
Speaker Points, Speaker Rank and Strength of Schedule. Before discussing the old and new tiebreakers,
each data point should be analyzed.

Speaker Points. Speaker Points range from 6 to 30. In practice, judges tend to award
Speaker Points in the range of about 15 to 30 with most judges awarding between 20 to 30 points. Wide
variations in the possible scores exist. Speaker Points is the most arbitrary of the data points because
judges may assign whatever scores they want including the same score for all debaters. As a result, the
Speaker Points in any debate may or may not be relative to other debaters in the room because the scores
may all be different or all be the same. The range of scores may be wide or narrow (or tied).
Some people believe that earning Speaker Points is primarily under the control of the speaker:
speak well and receive high points or speak poorly and receive low points. Others contend that Speaker
Points is primarily under the control of the judge because: (1) some judges “correctly” award high
Speaker Points to good speakers and low Speaker Points to weaker speakers, (2) some judges
“incorrectly” award high Speaker Points to novices, (3) other judges “incorrectly” award low Speaker
Points to excellent speakers and (4) the strength of the opponent’s speaking ability can influence the
outcome.
The primary problem with Speaker Points is that it is difficult to accurately compare debaters in
one room to debaters to another room. Debaters are debating for different judges in different rooms
against different opponents of different talent levels. The worst speaker in one room might be better
than all the speakers in another room and vice versa. A meaningful comparison is difficult. Admittedly,
this problem is true no matter which data points are being considered, including wins and losses.

Speaker Ranks. In each debate, the judge ranks the speaker in order (i.e. 1st, 2nd, 3rd, 4th).
Speaker Ranks range from 1 to 4 for Parliamentary debate and from 1 to 2 for Lincoln Douglas and
Individual Policy. Unlike Speaker Points, Speaker Ranks involves minimal variation and is a less
arbitrary data point. The judge must assign a rank order for the debaters and no ties are possible. Thus,
ranks are always relative to other debaters in room (unlike Speaker Points).
Some people believe that earning Speaker Ranks is primarily under the control of the speaker:
speak well and receive high ranks or speak poorly and receive low ranks. Others contend that Speaker
Ranks is primarily under the control of the judge because: (1) some judges “correctly” award high
Speaker Ranks to good speakers and low Speaker Ranks to weaker speakers, (2) some judges
“incorrectly” award high Speaker Ranks to novices, (3) other judges “incorrectly” award low Speaker
Ranks to excellent speakers and (4) the strength of the opponent’s speaking ability can influence the
outcome.
As with Speaker Points, the primary problem with Speaker Ranks is that it is difficult to
accurately compare debaters in one room to debaters to another room. Debaters are debating for
different judges in different rooms against different opponents of different talent levels. The worst
speaker in one room might be better than all the speakers in another room and vice versa. A meaningful
comparison is difficult. Admittedly, this problem is true no matter which data points are being
considered, including wins and losses.

Understanding Stoa Debate Tiebreakers

40

© Stoa

Rev 10/16

Strength of Schedule. Strength of Schedule refers to the combined Win/Loss record of the
opposition. So if Team A faces six teams in a tournament and those six opponents finish the preliminary
rounds with records of 5-1, 5-1, 4-2, 4-2, 3-3 and 1-5, the Strength of Schedule for Team A is 22-14.
Strength of Schedule is a general measure of the level of competition faced during the tournament. It is
a cumulative sum of rounds won and loss by all opponents at a tournament.
Some teams will face easier competition during a tournament and others will face tougher
competition. This regularly happens for a variety of reasons.
First, most tournaments power match which means the tab software tries to match teams against
each other which have the same records (e.g. 4-0 teams against 4-0 teams in the fifth round and 5-0
teams against 5-0 teams in the sixth round, etc.). Successful teams face more successful teams and
unsuccessful teams face more unsuccessful teams. Simply put, the more you win, the more tough teams
you face in future rounds. The more you lose, the more you are paired against easier teams in future
rounds.
Second, subsequence performance by an opponent will affect a team’s Strength of Schedule. So,
for example, assume Teams A and B never debate each other but (1) they both finish 5-1 and (2) in each
of the six rounds Teams A and B debated others team with the same record as Teams A and B (i.e. both
Team A and B were 3-0 after three rounds and they debated other 3-0 teams in the fourth round, etc.). If
the opponents of Team B lost all their subsequent rounds after debating Team B but the opponents of
Team A all won their subsequent rounds after debating Team A, then the Strength of Schedule of
Team A would be greater than Team B.
Third, some rounds are randomized instead of power matched (for example, the first preliminary
round).
Fourth, the computer cannot always match teams in a round with the same Win/Loss record. For
example, a tournament might have an odd number of 4-0 or 3-1 teams heading in to the fifth round
resulting in “pull-ups” (i.e. a 4-0 team facing a 3-1 team).
Fifth, side constraints, club protection, prior opponents protection and other factors will
sometimes result in other pull-ups such as a 5-0 team debating a 4-1 team in the sixth round.

Tiebreaker Problem. So how should tournaments use Speaker Points, Speaker Ranks and
Strength of Schedule when breaking ties? How should these three data points be used to determine a
team’s rank within a particular Win/Loss bracket? In past years, the tiebreakers were applied serially.
The computer looked at the first tiebreaker before all others. The second tiebreaker was only used if
there was a tie at the first tiebreaker. The third tiebreaker was only used if there was a tie at the second
tiebreaker. The fourth tiebreaker was only used if there was a tie at the third tiebreaker. The fifth
tiebreaker was only used if there was a tie at the fourth tiebreaker. This process continued through all
the given tiebreakers.
In the past, the first tiebreaker was traditionally a variation on Speaker Points and the second
tiebreaker was traditionally a variation on Speaker Ranks. Subsequent tiebreakers usually went back
and forth on additional variations of Speaker Points and Speaker Ranks. Strength of Schedule was used
far down the list, if at all.
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The main problem with this method was that two thirds of the data collected round by round was
not being used to determine ranking within the bracket. Speaker Points were being used to the
significant exclusion of the other data points. Speaker Points were being looked at independent of how
the speakers ranked and who they were debating to earn the Speaker Points. The first tiebreaker
(Speaker Points) often broke ties and, when that occurred, neither Speaker Rank nor Strength of
Schedule was used at all.

Tiebreaker Solution. Stoa Tab sought to develop a method that incorporated all three data
points in parallel fashion rather that in a series. Applying all three data points at the same time by
combining them is superior to applying them one at a time because, in the past, ties were often broken
based on Speaker Points alone. As a result, the current tiebreaker system creates a bracket ranking
(Win/Loss bracket) using all three data points and is similar to the room ranking system used in speech
events.
The first Win/Loss bracket tiebreaker (STOA Re-Rank = Bracket Rank) is calculated as follows:
Each of the three data points (Speaker Points, Speaker Rank, and Strength of Schedule) is ranked for
each team within a Win/Loss bracket and assigned an ordinal, e.g. 1 for first, 2 for second, 3 for third,
etc. The three rankings are then combined to create the first tiebreaker: the summation STOA Re-Rank
for each team. Subsequent tiebreakers (after the summation STOA Re-Rank) are based on variations on
the summation STOA Re-Rank and, thereafter, the older tiebreaking methods are utilized.

This system provides many advantages. For example, think of the situation (discussed
earlier) in which a judge gives all the debaters in a TP or Parli room 30 Speaker Points. While this is
good for the few fortunate students in this room, it hurts other students in all the other debate rooms who
did not benefit from this one judge’s generosity. Maybe all four speakers were truly outstanding, but it
is unlikely that each was a “perfect” speaker. Serial tiebreakers (the old method) consider only these
Speaker Points. Parallel tiebreakers (Stoa method) consider that although each speaker received a 30,
they were also ranked 1, 2, 3, 4 (for Parli or TP) or 1, 2 (for LDV). Incorporating Speaker Ranks into
the first tiebreaker mitigates the impact of one judge giving all four debaters 30 Speaker Points.
The same result occurs if a judge gives every speaker in a debate 15 Speaker Points. While
unfortunate for the students before this judge it helps all the other students in all the other debates who
were not hurt by this one judge awarding low points. Maybe all four speakers were truly poor speakers,
but it is unlikely. Serial tiebreakers (old method) consider only these Speaker Points. Parallel
tiebreakers (Stoa method) consider that although each speaker received a 15, they were also ranked 1, 2,
3, 4 (for Parli or TP) or 1, 2 (for LDV). Incorporating Speaker Ranks into the first tiebreaker mitigates
the impact of one judge giving four debaters all 15 Speaker Points.
Overall, in every round, Speaker Points are considered, but they are balanced with Speaker
Ranks within the room, which provides better results when reconciling diverse data. One student may
receive a 30 and be the top speaker in the room and another student may receive a 30, but is the fourth
speaker in the room. Another student may receive a 15 and be the fourth speaker in the room and
another student may receive a 15, but is the top speaker in the room. The parallel application of Speaker
Points and Speaker Ranks goes a long way toward balancing out the disparity between judges who give
high Speaker Points, low Speaker Points, high Speaker Ranks and low Speaker Ranks. Overall, it is
much fairer to the students.

Understanding Stoa Debate Tiebreakers

42

© Stoa

Rev 10/16

Likewise, the strength of the opponent against which the Speaker Points and Speaker Ranks were
earned is also taken into consideration, which provides better results when reconciling diverse data. One
student may debate the top team at the tournament and receive lower scores for Speaker Points and
Speaker Ranks because their opponent is so strong. Another student debates the worst team at the
tournament and receives high scores for Speaker Points and Speaker Ranks because their opponent is
not as strong. The parallel application of Speaker Points, Speaker Ranks, and Strength of Schedule
helps balance out the disparity that occurs in Speaker Points and Speaker Ranks based on how strong or
weak the debater’s opponent is.
As a result, Stoa decided to give a one-third weight to each of the three data points and to utilize
an approach similar to that used for ranking speakers in speech events. Consequently, two-thirds of the
weighting is given to a team’s speaking ability (Speaker Points plus Speaker Ranks) and one-third to the
team’s Strength of Schedule. This improved overall fairness.
The summation STOA Re-Rank (the first bracket tiebreaker), and the next group of
tiebreakers based on variations of the summation STOA Re-Rank, account for and reflect
virtually every combination of teams being benefitted by or hurt by facing better or weaker teams,
teams with better or worse records and teams that are better or worse speakers. The Stoa parallel
tiebreakers also ameliorate the harmful impact of “pull-up” rounds (e.g. a team is 2-2 and should
debate another 2-2 team, but they get pulled up to debate a 3-1 team).
A significant disadvantage under the old tiebreaking method was that a team may be pulled up
multiple times to debate opponents with a better record. This could happen multiple times to the same
team placing that team at a significant disadvantage.
However, the new blended tiebreakers prevent a team from being pulled up multiple times.
Once a team is pulled up it gains the benefit of the Strength of Schedule of the team with the better
record. Based on the algorithm for pull-ups, the team should only be pulled up once each tournament.
The larger the tournament, the more this will be true. Even at smaller tournaments, the number of pullups will be balanced out amongst the competing teams rather than some teams being disadvantaged
relative to other teams by being assigned multiple pull-up rounds. Even if the team loses the pull-up
round to the team with the better record, they are benefitted by “taking on” the better Strength of
Schedule from the team with the better record.

Conclusion. The Stoa Tiebreakers (the blended/parallel tiebreakers) are applied
throughout the tournament and improve the quality of the power matching even more as the
tournament progresses. Tournament results are improved because they take into account
Speaker Points, Speaker Rank and Strength of Schedule all at the same time in a balanced
fashion.
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W. Recommendations for When Things Go Wrong
By NITOC Tab Directors, Speech and Debate Committees
Thank you for serving Stoa families as part of the tournament administration and tabulation team. This
document was assembled to help you in this process because tournaments rarely run flawlessly from
start to finish. Often something unexpected comes up and usually at the most inopportune time...a
student gives a speech in the wrong room, a debate team can’t find their room and is late for the round,
students begin competing before all the judges have arrived, or a judge leaves before the round is
complete. These situations create stress as tournament administrators are often under pressure to make
rapid, time limited, decisions while attempting to balance any number of competing agendas. Often the
best time to make these decisions is not during the hurry of a tournament, but at another time allowing
for more careful consideration and reflection. This document is a humble attempt to do just that.
This document was assembled with input from NITOC Tournament Directors, NITOC Tabulation
Directors, the NITOC tabulation team, and the Speech and Debate Committees to provide guidance for
what to do at NITOC and local tournaments when events don’t proceed as planned. The following
scenarios have occurred, or could reasonably be expected to occur, at tournaments with suggestions for
how best to handle these situations. Having this information available may help to alleviate unnecessary
stress for tournament staff.
This document is not an exhaustive list of all possible scenarios, nor is it meant to address every unusual
circumstance that will occur at NITOC or other tournaments. There will likely be unique situations that
do not fit neatly into the scenarios presented. Lessons learned at tournaments will be added to this
document for future years. This document should give Stoa members an idea of the care, thought, and
planning that goes into administering both local tournaments and the National Championship
tournament.
Please understand that the suggestions presented are not mandates or “Stoa gospel,” but a concerted
effort by a group of fellow servants to provide helpful recommendations based on years of tournament
experience. To the extent that this document serves to help both local and national tournament
administrators then it has accomplished its purpose. Tournament administrators are always encouraged
to utilize the collective wisdom of the tournament administration team and tabulation team when
working through unforeseen circumstances.
A word about student/family expectations:
1. Students are expected to compete through the end of the tournament
a. Students that cannot compete through to Finals should not register for NITOC or local
tournaments as this places an unreasonable burden on the tournament administration and
tabulation staff
i. If students (or their parents by virtue of registering the student) misrepresent their
ability to compete throughout the tournament their place of finish may be demoted as
deemed necessary by the tournament administration staff
1. Student may not receive an award if one would have otherwise been earned
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SPEECH
1. Wrong event speech given (e.g. OI speech given in a DI room or OO given in Persuasive
room)
a. Wrong speech given first time during Finals, Semis, Quarters or Prelims
i. Student
1. In correct event room, but gives wrong event speech (e.g. student legitimately in
OI and DI, but student gives OI speech in DI room)
a. Student does not then get to deliver DI speech in DI room after already
having given OI speech in DI room, as student already gave wrong speech
i. Student does not deliver two speeches in same room
ii. Student may still deliver speech in correct room if time available to do
so (e.g. student goes to OI room and gives OI speech)
2. In wrong event room as student not entered in event, but student somehow
convinces judges that he/she should be in room (student not in event and not on
judges ballots, but allowed by judges to give speech)
a. Student may still deliver speech in correct room if time available to do so
3. In correct event, but delivers speech in wrong room. Student somehow
convinces judges that he/she should be in room (student entered in event, but
not on judges ballots because he/she is in the wrong room, but allowed by
judges to give speech)
a. Student may still deliver speech in correct room if time available to do so
ii. Judges
1. No judge instruction may be necessary depending on circumstances
2. If judges aware of some issue or mistake as in Scenario 1 (student gives wrong
speech in room)
a. Instruct judges to judge all students in room, but judges should not listen
to same student twice
3. If judges aware of some issue or mistake as in Scenario 2 or 3 (student not
scheduled in room, but somehow allowed to speak in room)
a. Pull student ballot from judges for the student not scheduled in room
b. Judges given extra ballot as needed
iii. Tab
1. Placing of student giving wrong speech depends on which round the wrong
speech was given
a. If student scheduled in event for a particular round
i. If Finals – student places 8th
1. Wrong speech student placed 8th - other ballots are adjusted to
rank students 1 through 7
ii. If Semis – student places as lowest ranked Semifinalist
1. In room - wrong speech student placed last in room - other
ballots are adjusted to rank students1 through next to last
iii. If Quarters – student places as lowest ranked Quarterfinalist
1. In room - wrong speech student placed last in room - other
ballots are adjusted to rank students1 through next to last
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iv. If Prelims – student placed last in event if correct speech presented in
other prelim rounds
1. In room - wrong speech student placed last in room - other
ballots are adjusted to rank students1 through next to last
v. If Prelims – student DQ if gave wrong speech in all three prelim
rounds
b. If student not scheduled to be in event for particular round
i. If Finals – All ballots for wrong speech discarded and placing in room
removed
1. Other ballots are adjusted to rank students1 through 8
ii. If Semis – All ballots for wrong speech discarded and placing in room
removed
1. Other ballots are adjusted to rank students first to last
iii. If Quarters – All ballots for wrong speech discarded and placing in
room removed
1. Other ballots are adjusted to rank students first to last
iv. If Prelims – All ballots for wrong speech discarded and placing in
room removed
1. Other ballots are adjusted to rank students first to last
b. Wrong speech given in an earlier round and student advanced based on results from
having delivered wrong speech
i. Student in Finals
1. Student has already delivered speech in Finals
a. Student
i. Top non-advancing student is contacted and allowed to compete in
Finals
1. If extra student found – gives speech
2. If extra student not found – no further action
b. Judges
i. If extra student found - judges given extra ballot and instructed to rank
all 9 students
ii. If extra student not found – no action concerning judges
c. Tab
i. Speech not considered to have happened in round
ii. All ballots for wrong speech discarded and placing in room removed
iii. Remaining student scores adjusted based on removed scores
1. Students placing below removed student will have placement
advanced one place
2. Students placing above removed student will not have
placement affected
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iv. Placing of student giving wrong speech depends on which prior round
the wrong speech was given
1. If Semis – student placed as top non-advancing Quarterfinalist
(or top non-advancing Prelim student if no Quarters)
2. If Quarters – student placed as top non-advancing Prelim
student
3. If Prelims – student placed last in event if correct speech
presented in other prelim rounds
4. If Prelims – student DQ if gave wrong speech in all three prelim
rounds
v. All other student results adjusted accordingly
2. Student has not yet delivered speech in Finals
a. Student
i. Student removed from room
ii. Top non-advancing student is contacted and allowed to compete in
Finals
1. If extra student found – gives speech
2. If extra student not found – no further action
b. Judges
i. If extra student found –
1. If time permits - judges given new tabulation and student ballots
by Tab
2. If time not permitting - judges cross off name of wrong
competitor on judge tab ballot and student ballot and replace
with correct competitor
ii. If extra student not found – no action concerning judges
c. Tab
i. Extra student found
1. Wrong student replaced with top prior non-advancing student
2. If time permits – tab reprints judge tabulation and student
ballots for judges
3. Tab normally
ii. Extra student not found
1. Tab normally with one fewer student
iii. Placing of student giving wrong speech depends on which prior round
the wrong speech was given
1. If Semis – student placed as top non-advancing Quarterfinalist
(or top non-advancing Prelim student if no Quarters)
2. If Quarters – student placed as top non-advancing Prelim
student
3. If Prelims – student placed last in event if correct speech
presented in other prelim rounds
4. If Prelims – student DQ if gave wrong speech in all three prelim
rounds
iv. All other student results adjusted accordingly
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b. Wrong speech given in an earlier round and student advanced based on results from
having delivered wrong speech (continued)
ii. Student in Semifinals
1. Student has already delivered speech in Semis
a. Student
i. Top non-advancing student is contacted and allowed to compete in
Semifinals
1. Rooms should be balanced
2. If extra student found – gives speech
3. If extra student not found – no further action
b. Judges
i. If extra student found - judges given extra ballot and instructed to rank
all 9 students
ii. If extra student not found – no action concerning judges
c. Tab
i. Speech not considered to have happened in round
ii. All ballots for wrong speech discarded and placing in room removed
iii. Remaining student scores adjusted based on removed scores
1. Students placing below removed student will have placement
advanced one place
2. Students placing above removed student will not have
placement affected
iv. Placing of student giving wrong speech depends on which prior round
the wrong speech was given
1. If Quarters – student placed as top non-advancing Prelim
student
2. If Prelims – student placed last in event if correct speech
presented in other prelim rounds
3. If Prelims – student DQ if gave wrong speech in all three prelim
rounds
v. All other student results adjusted accordingl
2. Student has not yet delivered speech in Semis
a. Student
i. Student removed from room
ii. Top non-advancing student is contacted and allowed to compete in
Semifinals
1. Rooms should be balanced
2. If extra student found – gives speech
3. If extra student not found – no further action
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b. Wrong speech given in an earlier round and student advanced based on results from
having delivered wrong speech – Student has not yet delivered speech in Semis (continued)
b. Judges
i. If extra student found –
1. If time permits - judges given new tabulation and student ballots
by Tab
2. If time not permitting - judges cross off name of wrong
competitor on judge tab ballot and student ballot and replace
with correct competitor
ii. If extra student not found – no action concerning judges
c. Tab
i. Extra student found
1. Wrong student replaced with top prior non-advancing student
2. If time permits – tab reprints judge tabulation and student
ballots for judges
3. Tab normally
ii. Extra student not found
1. Tab normally with one fewer student
iii. Placing of student giving wrong speech depends on which prior round
the wrong speech was given
1. If Quarters – student placed as top non-advancing Prelim
student
2. If Prelims – student placed last in event if correct speech
presented in other prelim rounds
3. If Prelims – student DQ if gave wrong speech in all three prelim
rounds
iv. All other student results adjusted accordingly
iii. Student in Quarterfinals
1. Student has already delivered speech in Quarters
a. Student
i. Top non-advancing student is contacted and allowed to compete in
Quarterfinals
1. Rooms should be balanced
2. If extra student found – gives speech
3. If extra student not found – no further action
b. Judges
i. If extra student found - judges given extra ballot and instructed to rank
all 9 students
ii. If extra student not found – no action concerning judges
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c. Tab
i. Speech not considered to have happened in round
ii. All ballots for wrong speech discarded and placing in room removed
iii. Remaining student scores adjusted based on removed scores
1. Students placing below removed student will have placement
advanced one place
2. Students placing above removed student will not have
placement affected
iv. Placing of student giving wrong speech depends on which prior round
the wrong speech was given
1. If Prelims – student placed last in event if correct speech
presented in other prelim rounds
2. If Prelims – student DQ if gave wrong speech in all three prelim
rounds
v. All other student results adjusted accordingly
2. Student has not yet delivered speech in Quarters
a. Student
i. Student removed from room
ii. Top non-advancing student is contacted and allowed to compete in
Quarterfinals
1. Rooms should be balanced
2. If extra student found – gives speech
3. If extra student not found – no further action
b. Judges
i. If extra student found –
1. If time permits - judges given new tabulation and student ballots
by Tab
2. If time not permitting - judges cross off name of wrong
competitor on judge tab ballot and student ballot and replace
with correct competitor
ii. If extra student not found – no action concerning judges
c. Tab
i. Extra student found
1. Wrong student replaced with top prior non-advancing student
2. If time permits – tab reprints judge tabulation and student
ballots for judges
3. Tab normally
ii. Extra student not found
1. Tab normally with one fewer student
iii. Placing of student giving wrong speech depends on which prior round
the wrong speech was given
1. If Prelims – student placed last in event if correct speech
presented in other prelim rounds
2. If Prelims – student DQ if gave wrong speech in all three prelim
rounds
iv. All other student results adjusted accordingly
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2. Speech delivered prior to all judges being present in room
a. Platform or Interpretive Speech
i. Student
1. Gives speech to missing judge(s) after other students have delivered speeches
a. Other judges who have heard speech dismissed
ii. Judges
1. Missing judge(s) listens to speech
a. Other judges who have heard speech dismissed
2. Judges rank all students from 1 to N
iii. Tab
1. Tab normally
b. Limited Prep Speech
i. Student
1. Students draws new topic
2. Gives speech to missing judge(s) after other students have delivered speeches
a. Other judges who have heard speech dismissed
ii. Judges
1. Missing judge(s) listens to speech
a. Other judges who have heard speech dismissed
2. Judges rank all students from 1 to N
iii. Tab
1. Tab normally
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3. Judge(s) does not listen to all speeches in room
a. Outrounds
i. Student
1. All students give speeches in round
ii. Judges
1. Remaining judges listen to all speeches
iii. Tab
1. Tab without missing judge(s) scores – discard ballots from missing judge(s)
a. If no ties – results stand
i. Hypothetical judge must be created to make event final rankings work
ii. Hypothetical judge rankings to match room rank
b. If ties – make following adjustments
i. Create a hypothetical judge (to make for odd numbered panel) by
averaging the scores of the other judges and creating ordinals (whole
numbers) for the hypothetical judge rankings
1. If tie broken – use results
ii. If tie is not broken, re-create the hypothetical judge ballot by adding
the inverse reciprocals of the judge’s rankings (e.g. 1 becomes 1/1=1,
2 becomes 1/2=0.5, 3 becomes 1/3=0.33, 4 becomes 1/4=0.25, etc) and
creating ordinals (whole numbers) with the higher totals becoming 1,
2, 3, 4…
1. If tie broken – use results
iii. If tie not broken – review prior rounds for students having competed in
front of same judge panel (priority: Semis > Quarters > Prelims) –
break the tie by giving the higher ranking to the student having
receiving the higher ranking in front of the other judge panel.
1. If tie broken – use results
iv. If tie not broken – give higher ranking to the student with the better
prelim ranking
1. If tie broken – use result
v. If tie not broken – review the ballot from the judge that did not hear all
the speeches. See if that judge did hear the speeches of the students
that are tied. If so use that judges rankings to break the tie.
1. If tie broken – use result
vi. If tie not broken – flip a coin
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3. Judge(s) does not listen to all speeches in room (continued)
b. Preliminary Rounds
i. Student
1. All students give speeches in round
ii. Judges
1. Remaining judges listen to all speeches
iii. Tab
1. Tab round without missing judge(s) scores
a. Review the section results without the ballot information from the missing
judge. Use those results (even if a tie exists) to replace the ballot for the
missing judge.
i. Create a hypothetical judge ballot to replace the ballot of the missing
judge by using the section results generated from using the ballots of
the remaining judges in the section and re-tab the section with all
ballots.
ii. This step is necessary so that there are the same number of judge
results for all students. Otherwise students with missing judge results
will be scored higher in overall preliminary round and tournament
results.
b. If this procedure generates no ties then the results will stand and no further
action is necessary.
c. If this procedure results in any ties, take no further immediate action, but
hold on to any ballots from the judge that did not listen to all of the
speeches.
i. Wait until all preliminary rounds have concluded.
ii. It is highly likely that the other ballots received by tied students in
prior or subsequent preliminary rounds will break the tie.
d. If a tie remains after preliminary rounds – does the tie affect who breaks?
i. If all tied students break to Outrounds then no further action is
required as the ties will likely be broken in Outrounds
ii. If some tied students do not break to Outrounds, the ties will need to
be broken.
1. Return to the problematic section in the preliminary round, but
DO NOT utilize the hypothetical ballot previously created in
Step 3.b.iii.a.i which used section results to create a hypothetical
ballot for the missing judge.
2. Instead, create a new hypothetical ballot (and replace the old
one) by averaging the scores of the other judges in the
problematic section and create ordinals (whole numbers) for the
hypothetical judge rankings.
a. If tie is broken – use results
Recommendations for When Things Go Wrong

53

© Stoa

Rev 11/16

3. If tie is not broken, re-create the hypothetical judge ballot by
adding the inverse reciprocals of the judge’s rankings (e.g. 1
becomes 1/1=1, 2 becomes 1/2=0.5, 3 becomes 1/3=0.33, 4
becomes 1/4=0.25, etc) and creating ordinals (whole numbers)
with the higher totals becoming 1, 2, 3, 4…
a. If tie is broken – use results
4. If tie is not broken, then review all other preliminary rounds for
instances in which the tied students competed in front of the
same judge panel (i.e. the same section) – break the tie by
giving the higher ranking to the student who receiving the
higher ranking in front of the other judge panel.
a. If tie broken – use results
5. If tie not broken, review the ballot from the judge that did not
hear all the speeches. See if that judge did hear the speeches of
the students that are tied. If so use that judges rankings to break
the tie.
a. If tie broken – use result
6. If tie not broken – flip a coin
4. Student misses full prep time for Extemp
a. Student at fault
i. Student responsible for time management
b. Tab at fault
i. Tab will make effort to give student full prep time
5. Student late to room
a. Goal is to keep tournament on time
b. Dealt with at the discretion of the tournament admin team based on the circumstances
c. Student
i. Responsible for managing time
d. Judges
i. Generally should not be made to wait for late students
e. Tab
i. If student does not deliver speech – rank last in room
6. Action to be taken if student suddenly cannot compete due to family emergency, illness,
etc…
a. Parent of student (or responsible adult) should immediately notify Tab that the student is
no longer able to compete
b. Parent (or responsible adult) will notify Tab of the reason for student withdrawal from
competition
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7. Student unable to compete in Finals
a. Is student replaced?
i. No
1. Unless student had previously scheduled engagement, then replaced by next
highest ranked student
b. Do only 7 students compete?
i. Yes
1. Unless student replaced secondary to previously scheduled engagement
c. Where does the student place?
i. Eighth
8. Student unable to compete in Semis
a. Is student replaced?
i. Yes
1. By next competitor in the rankings not previously advanced
b. Unbalanced rooms?
i. No
c. Where does the student place?
i. One place below the rankings for the current round
9. Student unable to compete in Quarters
a. Is student replaced?
i. Yes
1. By next competitor in the rankings not previously advanced
b. Unbalanced rooms?
i. No
c. Where does the student place?
i. One place below the rankings for the current round
10. Student unable to compete in Prelims
a. Student marked as "no show" in round or dropped if not competing
b. If discovered soon enough and rooms would be unbalanced, then rooms are re-sectioned
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DEBATE
1. Student/Team late to room
a. Goal is to keep tournament on time
b. Dealt with at the discretion of the tournament admin team based on the circumstances
c. Student
i. Responsible for managing time
d. Judges
i. Generally should not be made to wait for late students
e. Tab
i. If late student/team prevents debate from occurring – other student/team given forfeit
win
2. Students/Teams debate wrong side of resolution (Gov/Opp or Aff/Neg switch)
a. Students/Teams
i. Responsible for knowing correct side of resolution
b. Judges
i. Judge debate presented
c. Tab
i. Ballot(s) stand as judged
3. Debate begun prior to all judges being present in room (Outrounds)
a. Student/Team
i. Debate before judge(s) present – do not restart if single or odd number of judges
present
b. Judges
i. Present for entire debate
1. Judge debate as presented
2. Ballot counted
ii. Not present for entire debate
1. Ballot not counted
c. Tab
i. Ballots counted only from judges hearing entire debate
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4. Judge does not hear entire debate (judge leaves for any reason or does not render a
decision) –Prelims
a. If very early in round and time permitting
i. Students/Teams
1. Restart debate
ii. Judge
1. New judge assigned for debate
iii. Tab
1. Tab normally
b. If not very early in round or time not permitting
i. Students/Teams
1. Debate not repeated
ii. Judge
1. No new judge assigned
iii. Tab
1. Both teams given a Bye (Win)
5. Judge does not hear entire debate (judge leaves for any reason or does not render a
decision) --Outrounds
a. If very early in round and time permitting
i. Students/Teams
1. Restart debate – same sides of resolution
ii. Judges
1. New judges assigned for debate
iii. Tab
1. Tab normally
b. If not very early in round and no time available to allow for re-debate
i. Student/Team
1. Debate before judges present
ii. Judges
1. Present for entire debate
a. Judge debate as presented
b. Ballot counted
2. Not present for entire debate
a. Ballot not counted
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iii. Tab
1.
2.
3.
4.

Ballots counted only from judges hearing entire debate
If clear decision – ballots stand
If ballots tied – the team with the better preliminary round ranking wins
If tie not broken by preliminary round ranking – flip a coin

c. If not very early in round, but time available to allow for re-debate
i. Student/Team
1. Restart debate
2. Team Policy
a. If coin toss for sides in original debate
i. Team winning original coin toss may choose same side of debate for
re-debate or may choose opposite side of debate for re-debate
b. If teams locked for sides in original debate
i. Teams will now have debated on both sides of debate, so…
ii. Coin toss for sides with winner choosing Aff/Neg
3. Lincoln Douglas Value Debate
a. If coin toss for sides in original debate
i. Team winning original coin toss may choose same side of debate for
re-debate or may choose opposite side of debate for re-debate
b. If teams locked for sides in original debate
i. Teams will now have debated on both sides of debate, so…
ii. Coin toss for sides with winner choosing Aff/Neg
4. Parliamentary
a. New resolution
i. New resolution assigned by tournament admins, or…
ii. Teams choose from remaining resolutions not struck in current round,
or…
iii. Teams choose from among resolutions not debated in previous
Outrounds (as determined by tournament admins)
b. If coin toss for sides in original debate
i. Sides remain the same
c. If teams locked for sides in original debate
i. Sides remain the same
ii. Judges
1. New judges assigned for debate
iii. Tab
1. Tab normally
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6. Action to be taken if student suddenly cannot compete due to family emergency, illness, etc…
a. Parent of student (or responsible adult) should immediately notify Tab that the student is
no longer able to compete
b. Parent (or responsible adult) will notify Tab of the reason for student withdrawal from
competition
7. Student/Team unable to compete in Finals
a. Student/team replaced?
i. No
1. Exception is if previously scheduled engagement, then by next highest ranked
student/team not advancing
ii. Forfeit win assigned to remaining team
iii. Where does the student/team place?
1. Second
a. Unless replaced because of previously scheduled engagement – then
places Third or lower as determined by tournament administrators
8. Student/Team unable to compete in Semis
a. Student/team replaced?
i. Yes
1. By next highest ranked student/team not advancing
ii. Where does the student/team place?
1. One place below the rankings for the current round
9. Student/Team unable to compete in Quarters, Octos, Double Octos, Triple Octos or Down
Bracket
a. Student/team replaced?
i. Yes
1. By next highest ranked student/team not advancing
ii. Where does the student/team place?
1. One place below the rankings for the current round
10. Student/Team unable to compete in Prelim Rounds 1 – 6
a. Student/team will be given forfeit loss
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X. Update Log
Joy Manual
12.30.16
Added “[This does not apply to Section W, as these are simply recommendations and not tabulation
methods.]” to instructions not to change tabulation methods for tournaments unless posted to
tournament website before opening registration.
Added to Page 13 C.9.e.ii.VII that “Speaker Goal” can be ignored when setting up debate events
11.20.16
Added to Page 28 K.6 Entering Speech Ballots - Tab Director performs any necessary quality control
11.15.16
Updated Sections I, J, K, L, M, N, and O to match the updated Speech and Debate Workflow Tracking
Sheets. These sections and the Workflow Tracking Sheets were both updated with expanded language to
better clarify the process and procedure to be followed.

Recommendations for When Things Go Wrong
12.30.16
Updated Debate Section 5: Judge does not hear entire debate when re-debate is not possible.
Language updated to provide consistency with speech process by using preliminary round data to break
tie. Coin toss is a last resort that likely will never need to be used.
11.15.16
Updated Speech Section 3: Judge does not listen to all speeches in room.
Language updated and explanations expanded and clarified to make the recommended process easier to
follow.
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